AudioVisual Introduction

conference automation

This slide show will guide you thru Meeting Reporter. Meeting reporter is the ideal tool to report your
meetings. It’s like an archive where you can find all the reports of all the meetings.

But also, when you are at a meeting and delegates want to know the voting results of a meeting 2 months ago,
you select the meeting en present the voting results.

There are multiple ways to export the meeting report like PDF, PowerPoint, Word, Excel, RTF or Text. And if you
want to email or print it, that’s also possible.

You find Meeting Reporter at the desktop of your computer, please open Meeting Reporter, we’ll first show you
how you find a meeting and wherefore the buttons Print, Export and Email are, you can find them at the top of

BU W &Ee)e

Print  Export  Email  Settings Delegates  Calender Zoomin Zoom Out

The Zoom In and Zoom Out
buttons can be used to zoom in
or out.
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This is the index of Meeting Reporter, here you can select the report of a meeting or part(s) of a meeting.

File View Report! ReportTimePeriod Settings Language Help

several layers so you can .w | | i o ] . .
<5earch string(s)>

eaSily find the report Where ~ Print Export Email Settings Delegates Calender  ZoomIn Zoom Out
you looking for. Meetings and votings

» The index is subdivided in

» Select year > month >
meeting and optional >
agenda item or voting.
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In this slide we’ll explain to you how you can print a meeting.

>

Select and report a meeting
or part of meeting that you
want to print and click
Report at the lower left
corner of the window.

Click at the Print button.

&-[] 1

Semngs Del:gatﬁ

Emall

Meetmgs and votings

B[] 2015
EERRELY
2

-+{_) 09:06 Minutes from previous mesting
() 09:08 Review of Actions from Meeting

0 120he St g
-+{_) 09:14 Finance Committ=e"s Report

Page range

® Al

(") Current page
() pages:

Enter page numbers andlor page ranges,
separated by commas. For example, 1,3,5-12

File  View Repml' ReporlTlmePenod Settings language Help

mm«
<Search string(s)>

Calend:r

Zonm In Zonm Out

[ Print to file

Copies

Count:

@ @ 9 cotte

. o

Meeting Reporter Print Report

Select the printer you want
to use and set your favorite
settings.

Click Print. The meeting will
now be printed.
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Meeting Reporter Export Meeting To Document

In this slide we’ll explain to you how you can export a meeting to a document, you can choose multiple document
types, see picture.

>

Select and report a meeting
or part of meeting that you
want to export and click
Report at the lower left
corner of the window.

Click at the Export button.

File View Report! Report TimePeriod Settings Language Help

s Eee

Settings Delegates  Calender ZoomIn Zoom Out

<Search string(s)>

4.{7) 0%:14 Finance Committee’s Report

Description

Meeting Start

Meseting Stopped
Meeting Duration

Afttendance

Present
Absent

PRESENT

» Select the document type

where you want to export
the meeting to.

Give the document a name
en click Save. The meeting
will now be exported to the
document type you've
selected.
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In this slide we’ll explain to you how you can email a meeting. Make sure you setup the email settings.

» Select and report a meeting or part of oo e Resonimeorea_ g Lngioge » Select Include PowerPoint Report if
meeting that you want to email and click | . CAS .,[;m]s B you want to attach a PowerPoint
Report at the lower left corner of the Report of the meeting to the email.
window. TS i

Seran > Click Add Additional File to add and

»  Click Email. "B S:*:E:l“ additional file as an attachment to

" the email.
» Enter the email address(es) where you &

want to send the report to. » Enter Subject of the email.

» Select Include PDF Report if you want to - » At Body you can enter an
attach a PDF Report of the meeting to the accompanying message.
email.

» Click Send to send email.
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The next slides will give you some information about the settings menu. A very important menu because there
you setup all the options you want to see at the reports.
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Meeting Reporter settings

In this slide we’ll explain something about the settings from Meeting Reporter. You can change the settings by
adding or remove parts that you want or don’t want to see in the report.

> Click at the Settings button. AU ) (&) Gorercsens

A fle Llanguage Help
—

[m] X
Email server  Email Template  Camera Name Display (Virtual) Seat Sstup  Conference&Camera Interfacing
. . . . Seﬂinqs Dome Keyboard Remote Capture/Display
> Genenc Set‘“ngs Wlndow W||| appear' Voting Report  Meeting Report  Delegate Name Walermark Fonts Legend Page Aulomnatic Reporting
. These settings decide how voting results are printed.
open the tab Voting Report.
Vote report settings
[ Show Vote description [ Show Agenda name and Description
» Here you can select or deselect & Show Totas "
. ) . EA show Majority (Approved/Rejected Field)
options you want or don’t want in the

[ Hide Percentages
[ Show Bar and Pie graph
report about votes. [ Show "Not Voted' Results in totals
[ Show Group Vote Results

[] Show Group Graph in Numbers [ Show vertical group names

[#] Show groupimage(3:4) next to group-name

[ Show full page-wide (20:4) group image in stead of name.

[¥] Show Group Graph in Percentags
6 Group Graph Height (cm)

[ Show Individual Vots Results

[ Show Individual 'Not Voted' Results
[ sort by group [ Two delegates on one line
[ Sort by answer

[ Show Vote Weight

[] Show participant image in individual voting results
[ Hide voting results with 0 answers

[ Hide Classic Meeting Presenter entries (Requires application restart)

) o]
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Meeting Reporter settings

In this slide we’ll explain something about the settings from Meeting Reporter. You can change the settings so you
can add or remove parts that you want or don’t want to see in the report.

%, (L [/ Generic settings — m] X

> i i . :
Click at the Settllngs button A

File  Language Help

Email server  Email Template  Camera Name Display  (Virtual) SeatSstup  Conference&Camera Interfacing
SEﬂlnﬂS Dome Keyboard Remote Capture/Display

Generic settings window will appear, S e s e e e T e e
open the tab Meeting Report. When selecting 'vote results’, use the 'voting report’ tab for more voting options.
Meeting Report Settings
= eeting ription %] iled Vote results
> Here you can select or deselect e oo Sreonpemisasi
options you want or don’t want in the B ey (58 TS S T T Iy
. [ Show Agenda ltiems with no votes [ Show speechtimes per agendaitem
report about a meeting. Attendance Setiings Speech Time
EA Show Participants [ Show Speech Times

|1 Sort By Attendance
[ Show Attendance Duration
[ Show In and Outtimes

Show
[ Show Present Only ® s
O Show Summary

Method
O Show bytime

() Two delegates on one line
[] Sort by PresentiAbsent

Compensate timezone in hours
[ sort by group &

[~] Show Image of participants/attendance

[¥] Re-create report on any setting change

[] Hide Classic Meeting Presenter entries (Requires application resta (M
ng (Reaq ppl rt) I ”‘J&_ Close
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can add or remove parts that you want or don’t want to see in the report.

>

>

Click at the Settings button.

Settings

Generic settings window will

appear, open the tab Delegate
Name.

Here you can change some
settings about how you want to
see delegates names at the
reports.

|/ Generic settings - O 'Y

Fie Langusge Help

Email server Email Template Camera Name Display (Virtual) Seat Setup  Conference&Camera Interfacing
Dome Keyboard Remote Capture/Display

Woting Report Mesting Report Delegate Name Watermark Fonts Legend Page Automatic Reporting

Here you can modify the way a delegate name is printed (PrintLine)
Use the following opticns to create the name:

{1} = First Name
{2} = Middle name
{3} = Last Name
{4} = Title
{5} = Country MVI-CAM line 2
{6} = Group
Example:
143 {11 {21 {3} from (R}

PrintLine

Ii“{z) {3} inel ing order

e o s

Line 3
| Group Name D ~

Delegates sorting order 5

Here you can decide how a list of delegate names is Deutschland 2

sorted and in what priority: Nederland 3

France 4
- G :
Spain 8
Then on: Middle Name v

[] Hide Classic Meeting Presenter entries (Requires application restart)

oy

Meeting Reporter settings




AudioVisual Meeting Reporter settings

conference automation

In this slide we’ll explain something about the settings from Meeting Reporter. You can change the settings so you
can add or remove parts that you want or don’t want to see in the report.

. . 6 (G | /. Generic settings - 0
» Click at the Settings button. A o
= =) Email server | Email Template | Camera Name Display  (Virtual) Seat Setup | ConferencefCamera Interfacing
. . . . Settings Dome Keyboard Remote Capture/Display
» Generic settings window will appear, Voting Report Mesting Report  Delegate Name Watermark Fonts Legend Page  Automatic Reporting
open the tab Watermark. :xﬁ{éﬁ‘:::@;ﬁimﬁ;;?g:beusedtn|m:|udeynuroompanynrgavemmenﬂognnrtemp\ate
into the report.
Watermark
» Select Use Watermark. 7 Use Watermari

v
»  Click Select Image and choose an U 3
image you want to use as a watermark

and click Open.

» You can choose a transparency
percentage.

I Hide Classic Meeting Presenter entries (Requires application restart) u“JM_‘ cl
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In this slide we’ll explain something about the settings from Meeting Reporter. You can change the settings so you
can add or remove parts that you want or don’t want to see in the report.

. . s (|| A Genericsettings — O % |/ Genericsettings - o x
> Click at the Settlngs button. A Fle Language  Help Fle Language Heip
Email server Email Template Camera Name Display (Virlual) Seat Setup  Conference&Camera Interfacing Email server Email Template Camera Name Display (Virtual) Seat Setup  Conference&Camera Interfacing
e
Setti Dome Keyboard Remote Capture/Display Dome Keyboard Remote Capture/Display
. . . . Ings Vofing Report  Mesting Report  Delegate Name Watermark Fonts  Legend Page Automatic Reporting Voting Repert Meeting Report  Delegate Name Watermark Fonts Legend Page Automatic Reporting
» Generic settings window will appear, S Hereyoucanchange e fot o fort sz your ot
De-selecting 'Use Generic Font allows the user to have more control over the fonts and font sizes inside the De-selecting 'Use Generic Font' allows the user to have more control over the fonts and font sizes inside the
rts. reports.
open the tab Fonts. .
Font Selection Font Selection
[¥] Use one generic font Font Name Size [ Use one generic font Font Name Size
1 Arial |1 5 Arial Ml =
» Here you can change some settings s - e G
. . Page Header ‘Ana\ "‘ ‘15 E‘l
about fonts like the font itself and the fia &
. Main Title ‘A"a‘ "‘ 2 =]
font size
* Generic Title ‘Ana\ "‘ ‘14 E‘l
Delegates ‘A"ﬂ‘ “‘ i =

Table header ‘A"a‘ v‘ B S

» If you uncheck ‘Use one generic font’
you’ll be able to set different fonts
and font sizes for different parts of the

re p O r't . [ Hide Classic Meeting Presenter entries (Requires application restar) n = l.[] q ] Hide Classic Meeting Presenter entries (Requires application restart) h 2] |-[] u
o =
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can add or remove parts that you want or don’t want to see in the report.

>

>

Click at the Settings button. A

Settings

el
4. Generic settings

File  Language Help

Email server  Email Template  Camera Name Display  (Virtual) SeatSstup  Conference&Camera Interfacing
Dome Keyboard Remote Capture/Display

Generic settings window will appear,
open the tab Legend.

Here you can change some settings
about the legend colors.

Voling Repert  Meeting Report  Delegate Name  Watermark Fonts Legend Page Automatic Reperting

[ Open legend text sattings

|

Colors

J

[ Hide Classic Meeting Presenter entries (Requires application restart)

e

Meeting Reporter settings
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In this slide we’ll explain something about the settings from Meeting Reporter. You can change the settings so you
can add or remove parts that you want or don’t want to see in the report.

. . 8 [ [A] Generic settings — a *
» Click at the Settings button. A ———
) Emailserver Email Template Camers Name Display (Virtual) Seat Setup Conference&Camera Interfacing
. . . . Seﬂinqs Dome Keyboard Remote Capture/Display
> Genenc Set‘“ngs Wlndow W||| appear' Voling Report  Meeting Report Delegate Name Watermark Fonts Legend Page  Automatic Reporting

open t h e ta b Page . [ Special Auditsl Mode (Waring: Kesp deslected, customer specific)

[ Special mode 1 (warning: keep desslected, customer specific)
[ HideNonevoters

» Here you can change some page Page Header

. [] Show Empty Page Header
Settl ngs : Minimum Page Header Height (cm)

Borders

[7] Enable Borders in the generated documents

[] Hide Classic Meeting Presenter entries (Requires application restart) B'J'lJLH ’—‘
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|'a4/ Automatic Reporting Settings

‘What To Report
In this slide we’ll explain something about the settings from Meeting Reporter.| o
[ POF
) . b (s ] Generic settings - O X [ PowerPeint 2007
»  Click at the Settings button. A e —
Email server  Email Template Camera Name Display (Virtual) Seat Setup Conference&Camera Interfacing LllEc=ta
Settings Dome Keyboard Re.rrmie()apmrafD\spla/ When To Report
> Generic Settings WindOW will appear, Voting Report  Meeting Report  Delegate Name Watermark  Fonts Legend Page Automatic Reporting ot
. . Lem decide if report is saved, printed or emailed when a voting session and/or a mesting e —
open the tab Automatic Reporting.
/ Saved Reports Path
. _ R |c:\Users'\gemeente Groenlo\Deskiop\Reports
» Here you can change some settings Automatic Report Crealion
- i e
about automatic reporting. 1 At S
r—
) bl bt e
|4y Automatic Printing Settings — m] X
‘When To Report

[£] When a voting session ends

[#] When a meeting ends

PrinterSettings
[ Hide Classic Meeting Presenter entries (Requires application restart) mm |_| [Microsoft Prnt to PDF ~ e Propeties
Printer Options.
Number Of Capies !

G

M Collate.

Close
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In the next slide we will explain about Image Assistant.

The list with delegates we’ve added do all have their own photo.
In Image Assistant you be able to edit and change this photos. Of course you can use your own photos or choose to not
use this function.



AudioVisual

conference automation

More about Image Assistant.

Y

‘///

‘///

In Meeting Reporter
Click Delegates to open

Delegates

[#) Image Assistant

| [©)

* Delegates Groups (High) Groups (DCN Multimedia Background)

OaBc

the Image Assistant. =

Middle Name Last Name

Group

United Kingdom

Deutschland

2: Overview of all delegates. | ==

France

United Kingdom

3: Select Groups (high) to see | [*

group names and images.

4: MULTIMEDA ONLY Select
Groups (DCN Multimedia
Background) to see group
names and images as well.
This group images can be used
to display on multimedia

devices as background images.

\7/

\7/

A\

Image Assistant

5: Remove Delegate(s) will delete
selected delegate(s).

6: Remove Image will remove a
delegate’s image.

7: Load Image will open a window
where you can select an image for
selected delegate. You can use
your own image. Or open an
explore then go to the image
location and drag and drop the
images into the Image Assistant.

8: Use the —to resize an image.

9: Close will close this window.
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In the next slide we will explain the Calendar functions.

The calendar button r can be used as a sort of filter. For instance, when you’re at a meeting and you want to see
the voting results from a vote of a specific date, you select the date and you see the meetings and agenda items from
that specific date, select the meeting, or part of the meeting you want to report and click Report and there it is, you
can show it on the screens by clicking at the Show in Presenter button at the lower left corner of the screen.

At the top menu you find Report Time Period. This function allows you to select a period, like multiple days, weeks,
months or even a whole year and creates a report of it.
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In this slide we will explain the Calendar functions.

At the top menu you find
Report Time Period.

>

Select a period (start
and end date) that you
want to report..

Click Report! the report
of the period you've

selected will be created.

File

:Pn

l

Seﬂmgs Language H

) 18

Zoom |

View Reporl‘

»w

Calel\del
- o

This form allows you to create a report covering multiple meetings overa
certain timeframe. This includes reporting the attendance summary over that

nt El(pm‘t Emall S:ttmgs Delegates

Report Timeframe

period.
Select a start date. an end date then press Report!
Start Date

End Date
1 July 2015 1 July 2015

Mon Tue Wed Thu Fri Sat | Mon Tue Wed Thu Fri  Sat
29 10 1 2 3 4220 320 1 2 3 4
6 7 8 9 10 1| 6 7 8 9 10 11

13 14 15 16 17 12| 13 14 15 16 17
20 21 22 23 25| 20 21 22 23 [24] 25
27 28 29 2 N 1|27 2 29 320 33 1
3 04 5 6 7 & 3 4 5 & 7T &8
[ Today: 24/07/2015 [ Today: 24/07/201!

Click Calendar.

Select the month
and year.

Select specific day.

If you click Today
the calendar shows
all meetings of
today.

Meeting Reporter Calendar

m\l E(pn

EEE] ]
B duly

File  View Rapon'

Meetings and votmg «

Repon'r.mpumd Settings  Language Hzlp

Delegat: .

Zoom In Zunm()

[mal

Mon Tue Wed Thu Fri  Sat Sun
29 30

<Search string(s)>
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The following slides will show you more about red marked items from the top menu.

_ Report Time Period  Settings  Language | Help |
About Meeting Reporter
Open Manual

Settings see slides Meeting Reporter Settings.

Reset Presenter Control window

Language see slideshow Language Editor.
The Help menu has the following options.

For the Report Time Period menu see slide Meeting
Reporter Calendar.
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This slide is about the File menu. We explain what the functions are.

» Open in Explorer opens sub
menu.

» Export Settings export
settings so you can use
them again later, for
instance project based
settings.

» Import Settings import your
favorite settings that you’ve
saved before for instance
project based settings.

»  Exit will close the client.

YView Report! Report Time Period  Settings  Language

2015-07-24 1105 Approve Budget Changes

2015-07-24 11:09 Adopt Resolution to Change boand structure
201507-24 11:11 Adopt Resolution promoting Henry Keynes as
201507-24 11:12 Vote chaiman of commitee

Meeting Reporter Top Menu File

Active Database will open the
active database.

Auto-Generated Reports opens
the folder that contain the auto-
generated reports.

Program data (languages,
settings) opens program data
folder of Meeting Reporter.

Last used Archive Database
opens last used archive database.

» Last used export location opens
last used export location.



AudioVisual

conference automation

This slide is about the View menu. We explain what the functions are.

» Show only voting sessions
will show you only the
voting sessions and hide all
other reports.

» If you hide items and you
click Show Hidden Text it
will show the hidden items
like agenda items or voting
sessions from the list.

Report!  Report Time Period  Settings  Language  Help
MY
=Searc
Print  Export Email  Settings Delegates  Calender ZoomlIn Zoom Out

oting sessions only

ED 2015
D July

@ 2015-07-24 11:09 Approve Budget Changes

@ 2015-07-24 1105 Adopt Resolution to Change board structure
@ 2015-07-24 11:11 Adopt Resolution promoting Henry Keynes as
) 2015-07-24 11:12 Vate chaiman of commites

B 1

Meeting Reporter Top Menu View
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Meeting Reporter Top Menu Report

The following slides will show you more about red marked items from the top menu.

>

>

Report! will report the
items that you’ve selected
form the list, just like the
‘Report!” button at the
lower left corner of the
Meeting Reporter window.

Attendance will report only
the attendance of a selected
item from the list.

Show in Presenter only
available for voting sessions,
the results of a voting
sessions will be shown on
screen.

Language Help

» &)

ZoomIn Zeom Out

«5earch stri

alender

2015-07-24 Conference on company reforms
{3 11:07 Minutes from previous meeting
11:09 Review of Actions from Meeting
@ 11:09 Approve Budget Changes
(& 11:09 Adopt Resolution to Change board structu
11:11 Minutes from previous meeting
11:11 Review of Actions from Meeting

@ 11:11 Adopt Resolution promoting Henry Keynes
----- @ 11:12 Vote chaimman of commitee
- 11:12 Chief Executive™s Report
11:13 Finance Committee”s Report
-] 2015-07-24 Conference on company reforms
(] 2015-07-24 Corference on company reforms

£

H-{_) 2015-07-23 Conference on company reforms

» Report Without
Modifications will report
without modifications.

» Attendance will report only
the attendance of a selected
item from the list.

» Show in Presenter only

available for voting sessions,
the results of a voting
sessions will be shown on
screen.



